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BSBITU312
Create electronic presentations

Before you begin

This learner guide is based on the unit of competency BSBITU312 Create electronic
presentations, Release 1. Your trainer or training organisation must give you information
about this unit of competency as part of your training program. You can access the unit of
competency and assessment requirements at:

www.training.gov.au.

How to work through this learner guide

This learner guide contains a number of features that will assist you in your learning. Your
trainer will advise which parts of the learner guide you need to read, and which practice
tasks and learning checkpoints you need to complete. The features of this learner guide are

detailed in the following table.

Icon Feature of the
learner guide

Learning content

Examples

Practice tasks

Video clips

Summaries

Learning
checkpoints

How you can use each feature

Read each topic in this learner guide. If you come across
content that is confusing, make a note and discuss

it with your trainer. Your trainer is in the best position

to offer assistance. It is very important that you take

on some of the responsibility for the learning you will
undertake.

These highlight key learning points and provide realistic
examples of workplace situations.

Practice tasks give you the opportunity to put your skills
and knowledge into action. Your trainer will tell you
which practice tasks to complete.

Where QR codes appear, you can use a smartphone
or other device to access video clips relating to the
content. For information about how to download a QR
reader app or accessing video on your device, please
visit our website: www.aspirelr.com.au/help

Key learning points are provided at the end of each
topic.

There is a learning checkpoint at the end of each topic.
Your trainer will tell you which learning checkpoints to
complete. These checkpoints give you an opportunity to
check your progress and apply the skills and knowledge
you have learnt.
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Before you begin

Foundation skills

As you complete learning using this guide, you will be developing the foundation skills
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN)
skills and the employability skills required for participation in modern workplaces and

contemporary life.

The following table provides definitions for each foundation skill.

Foundation skill area

Reading

Writing

Oral communication

Navigate the world of work

Interact with others

Get the work done

Foundation skill description

Evaluates and integrates information and ideas to construct
meaning in an effort to design and create a presentation

Communicates relationships between ideas and information
in a style appropriate to audience and purpose in accordance
with organisational and task requirements

Listens to discussions and participates in exchange
of information to choose appropriate actions to create
presentation

Recognises and follows explicit and implicit protocols and
meets expectations associated with own role

Collaborates with others to achieve joint outcomes

Uses advanced features within applications to address
routine and complex work tasks

Plans and implements routine tasks and workload making
limited decisions on sequencing and timing

Unit release 1 (Aspire Version 1.1)
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Topic 1
Prepare to create a presentation

Most organisations need people with skills in designing and producing
electronic presentations.

Sharing information is a necessary activity in every workplace. You may have to take part

in a staff meeting or read a newsletter, and you will probably present information at some
time in your career. Information can be presented in written, graphic or verbal form. You
need to be able to communicate in all of these ways and know how to use a range of business
equipment and technology safely and effectively.

To work effectively in this area, you need to prepare your workspace by understanding safe
work practices and knowing how to identify hazards or risks to reduce workplace injury.
While a lot of the responsibility for workplace safety lies with the employer, employees must
also make an active contribution to ensure their workplace is safe.

To prepare a quality presentation, you must also be well informed. You need to take the time
to understand the purpose of the presentation, which includes knowing who it is for (the
audience), how it should be presented and in what format. Being well informed helps you to
create a relevant and professional presentation.

In this topic you will learn how to:

1A Use safe work practices

1B Determine the purpose, audience and method of presentation

1C Identify the task requirements and use the best application

Unit release 1 (Aspire Version 1.1)
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1 A Use safe work practices

Workplace safety is everyone’s responsibility.

Both employers and employees must make an active
contribution to ensuring their workplace is safe.
Hazards need to be identified and risks assessed

to reduce the risk of injury in the workplace. If

you are working at a computer for an extended
period of time each day, your workstation must be
comfortable and designed to help you carry out
your tasks efficiently. You will need to organise your
work so that you are not doing a repetitive task for
a long time. You should also take regular breaks to
stand up and stretch.

Another consideration is to use resource
conservation techniques to prevent wastage. Most
organisations require staff to follow resource-saving
procedures such as turning off lights in unused
rooms and recycling paper. You need to be aware of
any conservation efforts made by your organisation.

Health and safety legislative requirements

You must work in line with legislative requirements, regulations, Australian and
industry standards, and the relevant codes of practice.

All health and safety legislation requires employers to provide a safe workplace and
adequate training and supervision, while controlling workplace hazards and risks.

Health and safety regulations support the legislation by outlining specific health and safety
requirements that must be addressed.

The Model Work Health and Safety (WHS) Regulations provide a framework that has been
adopted by all Australian states and territories except for Victoria and Western Australia,
which have their own legislation and regulations.

Australian and industry standards provide best-practice guidelines for maintaining health
and safety in the workplace. For example, AS/NZS 4443-1997 Office panel systems —
Workstations outlines the ergonomic requirements for setting up a workstation.

Health and safety legislation outlines legal requirements such as:

* managing risks to health and safety

* promoting and maintaining the health, safety and welfare of people at work

* protecting people at work from injury and iliness, including psychological injury
* protecting the health and safety of the public in workplaces

* consulting workers and encouraging them to maintain health and safety

* providing rehabilitation and maximum recovery for injured workers.

Unit release 1 (Aspire Version 1.1)
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Health and safety policies and procedures

Health and safety policies and procedures are documents that ensure all
employees work safely and effectively.

All workplaces in Australia are required to have a health and safety policy in place that
describes the organisation’s and employees’ responsibility for maintaining health and safety.

The policy should include the organisation’s goals and objectives regarding health and
safety, and can help you fulfil your duty of care as an employee.

The following information relates to working in an office and using a computer workstation,
and should be contained in an organisation’s health and safety procedures.

Health and safety procedures outline:

e workstation ergonomics

» standard safety precautions and housekeeping

» safe handling of hazardous substances, e.g. cleaning products

* emergency and fire drills

* hazard identification and risk control

* manual handling

* emergency contact numbers, including local doctors and hospitals
e |ocation of first-aid equipment

» details of first-aid officers.

Control risks associated with hazardous manual tasks

Itis a legal requirement for the PCBU and workers to address the risks
associated with hazardous manual tasks in the workplace.

The WHS Regulations and the Code of Practice for Hazardous Manual Tasks outline
specific requirements for hazardous manual tasks that must be addressed.

The Hazardous Manual Tasks Code of Practice helps PCBUs and workers to:

 identify hazardous manual tasks

o assess the risks

« control the risks

« review the control measures.

A person conducting a business or undertaking (PCBU) must manage risks to health and

safety associated with undertaking a hazardous manual task, including risks of developing a
musculoskeletal disorder (MSD).

A PCBU must consult with workers, so far as it is reasonably practicable, to develop their
own set of procedures to manage the risk of MSDs.

Unit release 1 (Aspire Version 1.1)
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To determine which control measures to implement, the PCBU must consider the following:

e postures, movements, forces and vibration relating to the hazardous manual task

¢ the duration and frequency of the hazardous manual task

» work conditions that may affect the hazardous manual task or the worker performing it
* the design of the work area and layout of the workplace

* the systems of work used

* the nature, size, weight or number of people, animals or things involved in carrying
out the hazardous manual task.

Musculoskeletal disorders

The repetitive movements and sustained body position associated with
entering data into a computer is regarded as a hazardous manual task and puts
the operator at risk of developing an MSD.

MSDs come about in two main ways:

o gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs through
repeated or continuous use of the same body parts, including static body positions

» sudden damage caused by strenuous activity or unexpected movements, such as when
loads being handled move or change position suddenly.

MSDs may include conditions such as:

* sprains and strains of muscles, ligaments and tendons

* back injuries, including damage to the muscles, tendons, ligaments, spinal discs,
nerves, joints and bones

* joint and bone injuries or degeneration, including injuries to the shoulder, elbow,
wrist, hip, knee, ankle, hands and feet

* nerve injuries or compression, e.g. carpal tunnel syndrome

* muscular and vascular disorders as a result of hand-arm vibration
* soft tissue hernias

e chronic pain.

Standard precautions

Your organisation may require you to use standard precautions, particularly
work practices related to the prevention of repetitive strain injuries (RSIs).

These include ergonomic practices, workstation design, enforced breaks and regular exercise
routines. A workstation includes a computer, monitor, keyboard, mouse, desk and chair.

Workers in an office are expected to follow standard precautions when using a workstation,
particularly at a sit-down desk. Research on sitting has demonstrated that other precautions
also need to be considered, such as the use of standing workstations, to ensure that injuries
are prevented. It is important that you carefully follow any standard precautions that are
prescribed for your workplace.

Unit release 1 (Aspire Version 1.1)
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Equipment and systems safety checks

An important part of your daily work routine is to check the various systems
and equipment you use during the day to make sure they are in good working
order.

Your organisational policies and procedures should include steps to follow. You may need

to perform this procedure at the start of your work day or at specified intervals throughout
the day.

Workstation safety procedure/checklist:

O Ensure your seat is positioned in front of your computer and that you can reach your
keyboard comfortably.

O Position the monitor out of direct sunlight and at the correct height.

O Ensure the environment is dust-free as dust can affect the monitor or the computer’s
central processing unit (CPU).

U Ensure cables are secured so no one trips over them.

O

Use blinds and window coverings to reduce glare and heat at your workstation.

U Ensure temperatures do not exceed 26°C and that humidity is between 40 and 60
per cent.

Ergonomics

The aim of ergonomics is to reduce the risk of accidents, injury and illness by
applying safe work practices.

Ergonomics is about creating comfortable
working conditions by adapting
workstations, tools and equipment to

an individual worker’s needs. It also
improves performance and productivity
in the workplace. Ergonomics covers all
aspects of working, from physical stresses
such as sitting at a workstation all day to
environmental factors such as noise, air
conditioning and lighting.

When your posture is poor, you may suffer
from aches and pains. Spending a long time
in the same position can put stress on your
body and this can be made worse if you are
in an uncomfortable or poorly supported
position. These symptoms may be very
slight at first, but if you continue to have poor posture your symptoms may get worse and
become intolerable. They may result in cumulative stress given the constant strain on your
muscles, nerves and tendons.

When setting up your workstation, make sure your posture will not cause you pain or
discomfort. The equipment you use needs to be adjusted to suit your body shape and size,
and the tasks you are doing.

Unit release 1 (Aspire Version 1.1)
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Ergonomic workstation design

How your workstation is designed can affect your health and wellbeing.

Several physical problems can result from poor workstation design; for example, lower back
strain may result from sitting in a chair that does not support your back. Some features of
the workstation may vary depending on the type of computer work being performed.

Below are some guidelines for setting up an ergonomic workstation.
Chair

Adjust the seat height to suit your furniture and equipment. Ensure
that your feet are flat on the floor, your thighs are horizontal and
your lower legs are vertical. If possible, use a chair with a five-
castor base.

Adjust the backrest by raising it to the maximum height and then
ARG lowering it until it fits the curve of your lower back. If this is not
comfortable, lower it another couple of centimetres. Continue this
until it reaches a comfortable position.

The backrest should support your lower back, and may also be
adjusted backwards and forwards. When seated in your usual
working position, move the backrest until it has a gentle pressure
on your lower back. Make sure there is at least 2cm of space
between the front of the seat and the back of your knees. Armrests
should be positioned so that they do not interfere with carrying out
your work tasks.

Desk

Keep your head erect when seated at your desk, and ensure that
the surface of the desk is just below elbow height.

If your desk is not height-adjustable, try to raise your chair so you
are sitting at the correct height, and use a footrest, if necessary,
to make up the difference. Ensure there is clearance between the
lower edge of the desk and your legs, and between the front edge
of your seat and your desk.

If your desk is too low, you may be able to extend the legs. You
should have plenty of leg space underneath your desk. Don’t
clutter the space with bags and bins, as your legs may become
cramped and your posture may become twisted.

Position any equipment or materials you use so that you can reach
them easily without twisting. For example, place frequently used
stationery in the top desk drawer, and ensure your keyboard and
monitor sit directly in front of you to avoid having to twist your body.

6
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Keyboard

Mouse

Monitor

The angle of your keyboard can be adjusted to suit you by moving
the supports underneath it. Place the keyboard as close as
possible to the front of your desk. Have your upper arms hanging
freely. Your forearms should be approximately horizontal.

While typing it is best not to rest your wrists, as they should not

be bent up, down or to the side. The knuckle, wrist and top of the
forearm should form a straight line. Wrist supports give you a place
to rest your hands only when pausing from typing, not while you

are typing. Do not pound the keys; instead, use a light touch. Leave
enough room on your desk to put the keyboard out of the way when
you are not using it.

Don’t place documents between yourself and the keyboard,
as stretching will eventually cause muscle strain in your arms,
shoulders and neck.

Place the mouse and mouse pad directly beside your keyboard on
the side you prefer. If you use the mouse frequently, you could try
to alternate sides. You will be surprised at how easy this becomes
with practice. Your wrist should be straight and the desk should
support the weight of your wrist, not your arm. Try to keep your
wrist flat and rest your fingers on the mouse between clicks. Hold
the mouse lightly. Don’t hold onto the mouse when you are not
using it.

Once you have adjusted your chair and desk, you can position
your monitor. Adjust it so that the top of the monitor is level with or
slightly lower than your eyes. If you can’t adjust the monitor to the
correct height, place it on a platform.

The viewing distance should be between 40 cm and 70 cm. The
screen angle should be adjustable between 85 and 125 degrees.
It is best to position the screen so that you can clearly read the text
without having to lean forward, twist your neck or look upwards.

A relaxed viewing angle is approximately 35 degrees. Place a
document holder beneath or beside the monitor at the same
viewing distance as the screen.

Also take surrounding factors into consideration, such as reflection,
glare and shadow, when positioning your screen. You may need to
use an anti-glare filter.

Unit release 1 (Aspire Version 1.1)
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Desktop layout

Items on your desk, including equipment and resources, should be arranged so
they are within easy reach.
Your desk area can be divided into three zones:

o the optimum reach zone - the area closest to
you, where your hands operate most of the time

o the maximum reach zone - items are further
away, but still close enough to reach comfortably

\ -
« the outer reach zone - where you may have to <
bend forward or stand to reach items. 3 N\ )
i i

Make sure your desk is organised so that frequently
used objects, such as your keyboard, are close to
you. Objects that are used less frequently, such as
your phone, should be out of the way but still within
easy reach. Other resources that are rarely used,
such as in- and out-trays, should be in the outer
reach zone.

The following outlines some devices that can help you maintain a good posture at your
workstation.

Document holders \

Document holders are designed to hold papers and reference material in a
convenient position for viewing. Place your document holder in the correct
position. If it is below the screen or too far off to the side, each time your eyes
look from one source to the other, your pupils have to adjust. Doing this for long
periods of time can cause headaches and eyestrain. Place the document holder
at a similar level, angle and distance as the screen to avoid having to shift your
eye focus.

/

Angle boards \

Angle boards allow the user to maintain the correct posture when reading by
reducing the angle between the work surface and the user. These supports can
be adjusted to a suitable height and angle, and enable comfortable reading with
the neck correctly positioned. Try to keep your neck as straight as possible when
you are reading.

/

Footrests

A footrest may be necessary if you can’t place your feet comfortably on the
floor. Footrests allow your feet to rest at the correct height and on a tilting angle,
which prevents strain on the lower back.

8
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Headsets

If you use a telephone for long periods of time, it is a good idea to use a headset.
A headset will keep your neck straight and your arms free. Headsets prevent you
from bending your neck to support the telephone handpiece.

Setting up a home office

Communication technology and organisational policies to maintain a
sustainable work-life balance have created opportunities for more flexible
working arrangements.

This means that more employees are working from home offices or in other remote office
locations. Many benefits can be derived from flexible working arrangements for employers
and employees, but there is still a responsibility for all parties to make sure that home and
remote offices use ergonomic practices and follow health and safety requirements.

Hot desking
Hot desking refers to a system where workstations are not assigned to an individual
worker, but may be used by multiple workers during different periods of time.

The motivation behind hot desking is primarily the cost savings achieved by setting up
fewer workstations when not all the workers are in the office at the same time.

Another common adaptation of hot desking is where workstations are assigned to individual
workers, but need to be readily available for other workers to access based on daily work
requirements, such as a group of people coming together to work on a specific project.

Considerations with hot desking:

* |tis common for workers to want their own space. Consequently, they may choose one
location and stick to it.

* |t can take extra time each day to set up a workstation for each individual to maintain good
ergonomics and work efficiency.

* Personal hygiene needs to be maintained to prevent the spread of germs on items such as
keyboards and mouses.

* Workstations need to be tidied appropriately in readiness for the next user.

Unit release 1 (Aspire Version 1.1)
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Benefits of using standing desks

Sitting at a desk for long periods of time has many negative health effects.

These can be overcome by using standing desks. Standing provides a greater opportunity for
your body to move and adjust, and involves more muscular activity than sitting.

Some studies have shown that the negative effects of
prolonged sitting cannot be counteracted by regular

exercise. The only way to eliminate the problem is to e
avoid sitting as much as possible.

Some of the health benefits of standing include:
« alleviating back pain and other repetitive strain
injuries by greater use of core back muscles to

support the upper body
 increasing focus, alertness and activity level by
releasing restless energy

 reducing the risk of developing cardiovascular
disease, diabetes and blood clots, which can be

caused by prolonged sitting.

It is recommended that you start using a standing desk gradually by alternating between
sitting and standing. Using a standing desk for hours on end requires your body to adapt.
You may experience sore feet, tired legs and fatigue at first. Wear comfortable shoes and use
an anti-fatigue floor mat to help counteract this.

Ensure you have an ergonomically designed standing desk so that you maintain correct
posture while working.

Standing desk recommendations:

* Position arms at 90 degrees when standing.
* Place the computer screen at eye level and tilt it slightly upwards.
* Place the computer monitor at least arm’s length away.

* Keep your back straight and avoid leaning on the desk.

Monitor and adjust lighting

Good lighting is essential for a safe and hazard-free workplace.

You need to see things clearly in order to work effectively. Simply shifting the screen angle,
adjusting blinds, altering the brightness settings on the screen and using desk lamps can
reduce risks associated with poor lighting. Try to use natural sunlight rather than artificial
lights if possible. If not, keep bulbs and fixtures clean, focus light on your task and use
fluorescent lights to minimise eye strain and headaches.

10
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The following are hazards associated with poor lighting:

e Glare - A computer screen positioned in front of a bright window can be difficult to see.

¢ Flickering lights - A fluorescent light may malfunction, causing annoyance, irritation and
even nausea.

* |nadequate lighting - Reading in dim light can cause eyestrain.

* Shadows - Shadows shifting across your work area can cause you to sit with bad posture in
order to view your work.

Manage noise in the workplace

Noise can include any ongoing, loud or disturbing sound.

Excessive noise around machinery or equipment can cause permanent hearing loss.
Noise is a problem if it disturbs or distracts employees, causes stress or interferes with
communication or work.

Many offices are open-plan, often with employees seated close to each other and divided
by partitions at chest or head height. Think about noise levels when you set up your
workstation. It should be possible for people in open-plan offices to have some privacy when
they are on the phone and carrying out their day-to-day tasks.

Noise in the office can come from:

« machines and equipment, such as photocopiers, fax machines, phones and printers
 outside traffic and road works

o people talking to each other or on the phone.

Noise can also be a problem in other workplaces, such as on factory floors and at
construction sites. You may have to wear ear protection if you are required to work in an
excessively noisy environment.

There are many ways that noise can be controlled in the workplace. Examples include:

» Noisy machines can be put in a separate room or area.

« Sound-absorbent materials such as carpet and partitions can be installed or arranged to
deflect and absorb noise.

o The volume level on your speakers can be adjusted.
Remember that noise is only a hazard when it is stopping you from working productively,

comfortably or safely. Many people prefer to work with low levels of noise rather than
complete silence.
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Monitor and adjust air conditioners

Air-conditioning systems may cause hazards due to poor-quality air or
inadequate temperatures.

Air-conditioned offices often do not have enough
fresh air from open windows. This can cause
problems for some people. The air quality may need
to be adjusted by allowing more fresh air inside or
by improving the ventilation system.

Additionally, office workers frequently complain of
being too hot or too cold. If a person’s desk is near
an air-conditioning outlet, the area around their
desk can be much colder than elsewhere in the
office. They can also suffer from dry and itchy eyes.
Report such hazards to the relevant person. This
situation can usually be corrected by adjusting air-
conditioner settings.

Vary your activities

Make sure you plan your daily tasks so that you aren’t doing repetitive work for
long periods of time.

Having a well-planned workstation and comfortable
surroundings is pointless if you don’t organise your
work in a way that prevents discomfort or pain.

Your work role may involve several different tasks.
Some tasks may be repetitive, such as typing up
reports or entering data. If you are able to vary
the tasks you carry out each day, this will help to
prevent repetitive actions that cause stress to your
body. For example, if you have to enter a lot of
data, break up the repetitive nature of the task by
discussing a project with a colleague, doing some
research online or doing another work task.

You should also take regular breaks. Employers are
required to allow employees to take rest periods
throughout the day, including tea and lunch breaks,
to reduce stress and fatigue.

Take exercise breaks

Using computers for too long without breaks has been associated with back
and neck pain, headaches, migraines and eyestrain.

Try the following exercises several times a day, and encourage your colleagues to try
them too. Make sure you are relaxed and stretch gently, without overstretching. Stop if
you feel any pain or discomfort, and remember to exercise both sides of your body. Most
importantly, breathe deeply and evenly throughout the stretch.

12
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* Neck: Turn your head gently to look over your right shoulder. Hold for 10 seconds. Now roll
your head forward to look over your left shoulder and hold for 10 seconds. Repeat several
times.

e Shoulders: Sitting with a straight back and neck, roll your shoulders forward, then back.
Repeat several times.

e Wrists, hands and arms: Interlacing fingers, turn your palms upwards. Now lift your
arms over your head and stretch, leaning gently to the left and then to the right. Repeat
movement several times.

* Upper and lower back: In a standing position, place your hands in the small of your back.
Gently arch your back and hold for 10 seconds. Repeat when needed.

* Shoulders and arms: Stretch your arms above your head, cradle your elbow with your hand
and gently pull your elbow behind your head. Repeat on the other side, holding the stretch
for 10 seconds.

¢ Eyes: Every 20 minutes, look away from the screen. Focus on a distant object (more than
three metres away).

Watch a video demonstration of the above exercises here.

[=]

W
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Practice task 1

Here is a checklist to follow when setting up your workstation. Go through the points that are
relevant to you and make any necessary adjustments to your work area. You may need another
person to help you and check your posture. If you are not able to tick some of the checkpoints,
discuss making alterations to your workstation with your manager.

Chair

QO Is the seat height-adjustable?

O Is it high enough to allow you to sit comfortably at the keyboard?

Q Isit stable?

O Does it swivel?

O Is the height of the backrest adjustable and does it tilt backwards and forwards?
Q If it has arms, can you still get close enough to the desk and swivel the chair?

U Are your feet flat on the floor or are you using a footrest?

O Are you sitting up straight with the backrest firm against your back?

Desk

O Is it large enough to allow the screen and keyboard to be correctly positioned?
O Is it low enough to allow you to keep your forearms horizontal or sloping downwards?
O Is it high enough to allow your thighs to fit comfortably underneath?

Keyboard

O Can it be tilted to allow you to adjust it?
O Are the symbols on the keys clear and easy to see?
QO Is there sufficient space in front of it to allow you to correctly position your arms?

Monitor

O Does the monitor have easily adjustable brightness and contrast controls?
O Is the image on the monitor stable and flicker-free?

O Are there adjustment mechanisms to allow the monitor to be tilted, swivelled or raised
to avoid glare and reflections, and help you keep a natural and relaxed posture?

O Are you sitting far away enough from it for comfort?

Unit release 1 (Aspire Version 1.1)
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Question 2

Describe the possible consequences for an organisation in which employees do not consider
their physical health.

Question 3

What should a WHS policy include?

Question 4

What should WHS procedures include?

Why should you vary the tasks you carry out each day?

Question 6

What are the main aims of health and safety legislation?

Unit release 1 (Aspire Version 1.1)
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Determine the purpose, audience

and method of presentation

The purpose, audience and method of your presentation will influence its
content, organisational requirements, style and layout.

Many presentations are made with the input of
another person, such as an author or a specialist
speaker that you are preparing the presentation

for. The information and communication you

have with this person will determine many of the
decisions that you will make in the planning and
development of the presentation. The way you work
and collect information will be determined by

the policies and procedures you must follow. For
example, your organisation may have guidelines
about communication you have with external
clients or the way information can be shared in
email or at a public venue. You may need to confirm

your actions with a supervisor to make sure you are
operating and following correct procedures for gathering the information you need for the
presentation.

You must also find out about any legislation that may apply to the information in your
presentation. For example, make sure you comply with privacy laws (using only authorised
material) and follow anti-discrimination laws. Another example would be following the
laws of copyright when accessing someone else’s ideas or original work, such as an image or
design. The author has the right to determine under what conditions this work can be used
by others. Codes of practice outline standards of conduct for employees in an organisation.
You need to consider these codes to be confident your content does not contravene these
guidelines. For example, there may be a code outlining ethical principles such as honesty,
integrity and fairness. These principles may influence the way you obtain and present
information.

When you are new to presentations, always have your work checked by your supervisor
or an experienced colleague to make sure you have complied with relevant legislative
requirements.

Purpose Content
Audience Organisational requirements

Purpose of the presentation

Before you begin, you need to know what your electronic presentation is about.

You may have been asked to present information on a specific topic, or you may have
decided to present something that you believe will benefit your colleagues in some way.

16

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



Topic1
Prepare to create a presentation

Clarify the purpose with the content author or presenter to make sure you both fully
understand what your presentation is about. You should be aware of the intended message;
that is, what you want your audience to know. Your ability to explain with words, text and
graphics determines how clearly your message comes across. Start by writing a precise
statement of the purpose of your presentation; for example, ‘T have to explain new health
and safety regulations to my colleagues’.

Storyboards

Creating a storyboard can be a good way to help you understand the purpose
of your presentation.

Topic 1 Conclusions
i Bullet Bullet
Title Topics of > >
discussion Bullet Bullet
etc. etc.

A storyboard is basically an outline of the major points. It should give a general idea of
where text, pictures or charts will go and the order in which you will present them. You
can quickly sketch a storyboard by hand on paper. Identify items that need to be presented
earlier or later in the final presentation. Look for the most logical flow of understanding, or
the best impact on the audience and their retention of the information you are presenting —
rearranging the flow of your work if necessary. You can show this to the author or presenter
to see if you have presented the information in the best order.

Audience

If you take time to get to know your audience, the electronic presentation you

develop will be more successful.
Ve :
._’4 ,’

Find out who your audience is and what their

information needs are; for example:

o Isitan internal or an external client?

« Does the group all come from the same unit/site
or do the same job?

o What will they need to do after they have seen
the presentation; for example, will they need to
practise a task or skill as part of your planning?

o Are there any people with disability or
cultural issues that should be considered when
delivering the message?

o What sort of presentations worked best for the
group previously?

It is also important to find out what level of expertise your audience members have in regard
to your subject. If your audience is not knowledgeable about the content of your presentation
and you include fine details and jargon, people may become confused and bored. If you are
presenting to an external client, ask your manager for information about them. If you are
presenting to an internal client, you could prepare a questionnaire to find out their level of
existing knowledge.

Unit release 1 (Aspire Version 1.1)
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Method of presentation
Whatever presentation method you choose, the way you arrange the
information will depend on the situation.

The method you choose must suit both the purpose of your presentation and the audience,
and should enhance the audience’s ability to understand it. You need to hold the audience’s
attention and ensure that your information is easy to understand. You need to consider the
most useful method for the audience to receive the information and retain it, rather than
assuming it will be enough if they’ve seen it.

Here are several different ways to give a presentation.

Face to face

Presenting information face to face to an audience, such as at a seminar or staff
meeting.

Specialist speaker

Engaging a specialist speaker/demonstrator for certain aspects of the presentation.

Self-running

Choosing a ‘self-running’ mode, such as a looped video that runs continuously on a
TV monitor at an exhibition stand.

Self-paced

Designing a presentation for people to use themselves, such as at a conference,
training session, or in their own time at their desk. It may include activities to assess
their understanding of the tasks or material.

Online

Setting up the presentation on the internet or the organisation’s intranet. This
enables you to record the identity of the user/participant and acts as a method
of tracking and ensuring information has been accessed by relevant participants
wherever they are located.

Sent via email

The presentation can be saved as a PDF and sent as an attachment. It can be viewed
when the participant chooses to watch it.

18
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Practice task 2

Read the case study, then answer the questions that follow.

Case study

Kate works as an office administrator in a large organisation. Her manager asked her to prepare an
electronic presentation for external clients to explain upcoming projects. The clients were to view the
presentation at a board meeting.

Kate assumed the clients already knew a lot about this topic and focused instead on the financial
costs of each project, including forecasted profits. She also used information that management did
not want disclosed to the clients and she did not confirm all the information with management. Kate
set up a computer with a digital projector in the boardroom. The clients were to come in and look at
the presentation individually when they had time in the days leading up to the board meeting.

On the day of the board meeting, Kate found out the clients had no prior knowledge of the projects
and wanted a broad overview. She also discovered that the clients had difficulty working the
technology and were either unable to access the presentation or required assistance from others.

Give two examples of how Kate could have planned better before producing the presentation.

Question 2

What are the consequences of Kate’s poor planning?

Question 3

What content would have been more suitable for Kate’s audience?

Unit release 1 (Aspire Version 1.1)
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Identify the task requirements

1C

Production guidelines are used to develop time lines and a consistent
organisational style.

and use the best application

A time line is used to ensure there is enough time
to complete the task, edit and review before the
deadline is reached. A time line is a plan for how
long a task will take to complete. It also breaks
the task into steps and details when each step
needs to be completed by. Your supervisor will
often provide a date, but it will be your job to
monitor and report on your progress.

Production guidelines also ensure that
documents have a consistent style and image so
that customers, business associates and anyone
receiving material from your organisation

will instantly recognise it as belonging to your
organisation. These output requirements are
important because each time a client has contact with an organisation, they form an
opinion based on the documents they receive. In some instances an unprofessional-looking
document or one containing errors can be the difference between gaining and losing

a client.

Many organisations have policies and procedures for staft to follow, including style
guides and templates for producing documents. In larger organisations and government
departments they are usually clearly defined, while smaller organisations often have no
formal documented style guide; instead, staft may be expected to follow examples of
documents that have previously been produced.

Conforming to organisational requirements will also ensure you are able to complete your
work in an efficient and timely manner. It is very frustrating to spend hours working on the
design of a document, only to find it does not meet requirements. To avoid a situation like
this, there may be a simple template you could use. Speak to a colleague or your supervisor
if you are unsure.

Common organisational requirements

Every organisation has different requirements for their documents.

One important requirement is to present an appropriate and consistent corporate image by
using the organisation’s logo, colour scheme and house style.

Most organisations outline document production procedures and guidelines either in their
policies and procedures manual, or in an in-house style guide. Make sure you know where
these instructions are kept and that you are familiar with them. Your supervisor can assist
you to find the correct template, identify where the style guide is stored and rules about

its use.

The requirements appropriate for one organisation may not suit another; for example, a law
firm’s requirements would be different from that of a sports equipment retailer.

20
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To prepare appropriate documents for your organisation, you must follow established
guidelines and procedures for production.

Established guidelines and production procedures may include:

* monitoring the designated time line

* adhering to content restrictions

* using templates

¢ including the organisation’s logo or version control in the footer

* observing copyright legislation that restricts the use of someone else’s work
* delivering the content in the required format.

Equipment for completing the task

Presentation requirements refer to the many documents and equipment that
may be used to prepare for and deliver an electronic presentation in your
organisation.

You will use equipment such as a computer or laptop, monitor, projector, keyboard and
mouse to deliver an electronic presentation. The following provides some more information
about equipment you might use.

Data projector or display monitor \

A digital projector can be attached to a computer or tablet to project the

display onto a larger screen. A data projector is commonly used for PowerPoint
presentations, but it can be used to display almost any digital multimedia. Large
digital monitors or televisions can be used instead of a projector via direct
cabling or through a local area network, Wi-Fi network, internet or other wireless
technology such as Apple TV. Always test the equipment before the presentation
and ensure that the presenter is competent in using it.

/

Digital pointer or annotation pen I

When presenting information you might want to draw attention to an important
point on the screen. A handheld digital pointer can help you do this.

PowerPoint and a variety of other computer and tablet applications are now
providing freehand annotation tools that allow the presenter to write on each
presentation slide during the presentation. This can add or draw attention to
existing information. Some tablet-based applications can also make provision
for the audience to annotate presentations as a mechanism of audience
engagement.
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Sound equipment and visual monitors \

Audio speakers are often required even in smaller rooms, particularly if your
presentation has a video clip or uses sound effects. Sometimes in a large venue
it is necessary to install a background screen or extra screens around the room
so that all participants can see a visual display clearly (without straining) by
looking towards a stage area.

/

Network/internet access

To illustrate certain points you can provide a hyperlink to an interactive
presentation for participants’ use. This may require you to arrange with your IT
department to access logon privileges, and to be sure you are not breaching any
privacy issues regarding data that will be displayed.

Microphones N\

You may consider the use of a handheld microphone to help the audience
participate fully. Assistants can be organised to minimise delays and avoid
reducing the impact of the session. A lapel microphone can be used for the
speaker if they are not using a lectern and standing in one place while they
present information.

Speaker notes and handouts \

Having a hard copy of the presenter’s notes, internet documents or audience
handouts can add value to an electronic presentation.

You may have to write speaker notes or handouts for a presentation that you are
giving. Speaker notes are thumbnail sketches of each slide to be displayed. They
help the presenter remember the important points on each slide. This helps the
verbal presentation run smoothly.

The audience may also require handouts to repeat or add to information from
the presentation. Handouts can be formatted in a variety of ways and can
contain your notes and a space for the audience to add their notes.

Handouts can also be provided in digital format either before or after the
presentation. With the advent of smartphones and tablets, many people
consider an electronic version to be preferable as it reduces paper wastage and
is easy to store and access from a mobile device.

\_ /
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Selecting a suitable presentation application

The most commonly used software for presentations is Microsoft PowerPoint,
although some organisations prefer to use other programs.

The examples given in this learner guide are based on PowerPoint 2016. Earlier versions will
be similar in how they work, although there may be some differences in the appearance of
the screens.

The choice of application will depend on a number of factors, such as the cost of the
software which may come as part of a package. For example, Microsoft Office contains
Word, Publisher, Outlook and PowerPoint, as well as a range of other programs. The
application you are required to use may also depend on the platform used by the business,
which may be based on the nature of the business and the available resources. For example,
an organisation may predominantly use Microsoft software, but may also have one or more
Apple computers with other software installed.

The following table outlines some of the key features of different presentation software programs.

Presentation Key features
software

Microsoft PowerPoint Available as desktop software, online application and mobile app

* Able to access external data sources such as photos, images, charts,
animation, cinematic motion, 3D models and icons

e Provides various templates
¢ Allows cinematic transitions and effects for objects and text
¢ Able to communicate with other Microsoft Office programs, including
Word and Publisher
Prezi ¢ Provides templates in themes of template styles

* Flexibility in the organisation and presentation of slides through a
digital map

* Keeps track of who is viewing the presentation and what slides they
are interested in

¢ Available as desktop software, online application and mobile app
Keynote ¢ Cloud-based, allowing multiple users to work in the document at once
to collaborate on tasks
¢ Provides various templates

* Able to access external data sources such as photos, image galleries,
equations, charts, and a library of over 600 customisable shapes

¢ Available as desktop software, online application and mobile app
* Able to communicate with other Apple programs such as Apple Pencil
¢ Compatible with Microsoft PowerPoint
¢ Allows cinematic transitions and effects for objects and text
Google Slides * Cloud-based, allowing multiple users to work in the document at once
to collaborate on tasks
¢ Available as desktop software, online application and mobile app
* Keeps track of revision history
e Compatible with Microsoft PowerPoint
* Variety of templates available
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There are many organisational and reporting requirements, which will be outlined in
organisational policies and procedures. This information may be used to determine the
resources available to the company, including the specific software they can use. Be aware
of the spreadsheet software used in your organisation, and ensure you follow organisational
policies and procedures.

Practice task 3

Read the case study, then answer the questions that follow.

Case study

Phuong works as an administrative officer for a local council. She has recently moved into the
community development department from the rates department and is looking forward to the
change. Phuong has been asked by her supervisor to create a presentation with accompanying
handouts that summarises the number and types of small businesses in the area. She has also
been asked to set up the presentation room. Phuong is familiar with creating presentations using
the software; however, she is not sure how to find out the information to include in the report. She
wonders whether she has to go out and visit all the small businesses in the area.

Phuong decides to speak with her supervisor to clarify what is required. Phuong’s supervisor
explains that it is a report which is completed on an annual basis, so she should be able to access
last year’s presentation from the network drive. However, her supervisor is not sure of the file name,
so Phuong will need to a look for it. Her supervisor suggests that she follows the same layout and
presentation as last year’s report, although she should check that it has the current council logo

in the heading. Phuong asks her supervisor who the presentation will be given to. Her supervisor
explains it is to be presented at the upcoming management meeting next Friday. Her supervisor
has asked that she complete a draft of the layout by Wednesday morning so that he can check the
information. Once checked, 15 copies of the handout need to be produced.

What is Phuong’s task?

What does Phuong do to clarify task requirements?
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What equipment will Phuong need to complete her tasks?

Summary

o The aim of ergonomics is to reduce the risk of injury by applying safe work practices.

»  Your work environment can be organised in accordance with ergonomic requirements
by adapting workstations, tools and equipment to meet your needs and ensuring a safe,
comfortable and productive work environment.

« Organise your work tasks to ensure you have a balance of repetitive and other activities,
regular rest periods and exercise breaks.

+ The factors that are important for your planning include the purpose, audience and
method of presentation. These influence the content, organisational requirements, style
and layout of the presentation.

o A storyboard will help you plan and outline the best order of information in the
presentation.

« Find out about the audience and what their information needs are so the presentation
you develop will be more successful.

o Consider the most useful method for the audience to receive the information and retain
it, rather than assuming it will be enough if they’ve seen it.

o Production guidelines ensure that documents have a consistent style and image so that
customers, business associates and anyone receiving material from your organisation
will instantly recognise it as belonging to your organisation.

« Many organisations have policies and procedures for staff to follow, including style
guides and templates for producing documents.
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Learning checkpoint 1
Prepare to create a presentation

Part A

1. List types of physical discomfort a person may suffer from as a result of spending a lot of
time at a workstation.

2. For each type of physical discomfort you have listed, describe a solution that could help
to prevent or relieve it.

Unit release 1 (Aspire Version 1.1)
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3. Describe four types of office equipment you could use to help your posture in the
workplace. Explain the benefits of each piece of equipment.

4. Briefly explain two production guidelines or procedures and how they help in the
preparation of presentations.

5. Choose two pieces of equipment needed to make or share a presentation. Briefly outline
the features of each of these pieces of equipment.
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6. Outline three features of a piece of software used for presentations.

7. Are the following statements true or false? Tick the relevant column beside the

statement.
True False
The purpose, audience and method of your presentation will have |:| |:|
an impact on the content, organisational requirements, style and
layout.

Clarify the purpose of the presentation with the content author or
presenter so you know what your presentation is about.

If you know how to use a computer, you will be able to use a data
projector.

Having a hard copy of the presenter notes or audience handouts
can add value to an electronic presentation.

I I R I B
I I N I

Each person in your audience is likely to have approximately the
same level of expertise in the subject as you, so you should pitch
your presentation to the content you are comfortable with.

The audience will not remember everything from a presentation,
so handouts are useful, particularly if the presentation is about
something the audience needs to recall.

[
[]

You need to understand legislative requirements to be confident |:| |:|
your presentation complies with privacy and anti-discrimination
laws and ethical principles.

Two popular methods of presentation include online and face to |:| |:|
face.
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Part B

Read the case study, then answer the questions that follow.

Case study

Angelina works as an administration officer. Her main tasks are reception duties, word processing,
handling the mail and filing. Most days Angelina’s manager gives her urgent work in the afternoon
that needs to be completed that day. Her time lines are always very tight and she often finds that she
has to work during her lunch hour and for an extra half hour in the evening. She is always exhausted
and is becoming stressed.

To make matters worse, Angelina finds that work is often just dropped on her desk, which makes her
desk disorganised and difficult to use. She can't alter her chair and there is glare coming from her
monitor. She often leaves work with a headache and a backache.

1. List all the unsafe work practices Angelina experiences.

2. Describe a solution for each of the unsafe practices you have listed.
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The electronic presentation you create may need to be designed to meet specific
organisational style requirements; for example, using the corporate logo and
colours.

You will need to understand the functions of the software you will be using to make the
most of its features for visual impact and emphasis. During the design process you will need
to work within designated time lines to ensure the work is ready when it is needed. This
may be to meet a client’s requirements or be ready for a conference deadline. To meet the
deadlines and overcome any issues that arise, you need to know how to access and use the
various help functions and options available to you.

Although there are many different systems for producing presentations, this learner guide
will primarily focus on PowerPoint 2016 using the latest Windows operating system.

In this topic you will learn how to:

2A  Follow task and organisational requirements

2B Use software functions

2C Add balance and visual impact

2D Use advanced features to customise for the audience

2E  Overcome issues using help functions
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2 A Follow task and organisational requirements

Whatever your work task, you will always have to work within a designated
time line.

This means having the work ready by a specified
time. You may have to prepare a presentation for a
speaker or meet a deadline, such as a conference.

Always find out when the presentation is required
and enter this date in your diary. Clarify and plan
the task to work out how long it is likely to take.
Careful planning means there will be no last-
minute panic. If you are developing an electronic
presentation for someone else, always ask when a
draft of the material is required. The presenter will
generally want to rehearse the material and may
suggest further amendments or adjustments.

When beginning the task of developing a

presentation, you should have a good understanding of the requirements of the task,
including the purpose, audience and presentation requirements. Producing a plan of your
presentation before you begin will help you to keep on track. When creating a plan, consider
the purpose of the presentation, the audience and the presentation method you will use.

Here is a review of the information you need to start planning the presentation.

Purpose

* What is your presentation about?
*  Why is it needed?
e If you are in the workplace, discuss the purpose with your manager.

Audience T\

« Clarify the audience for your presentation; for example, colleagues at work
or fellow students.

¢ Once you identify your audience, decide how much they already know about
the subject you have chosen. This will help you determine how complex the
content of your presentation should be.

_/

Method of presentation

*  Your presentation may be shown to others online or face to face in a meeting.
¢ You may need to design speaker and handout notes.
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When this information has been clarified, you can prepare the content of your presentation
using a storyboard. Here is an example:

o Slide1 Title page with graphic

o Slide2 Introductory page, bullet points for three major topics

o Slides3-5  Content for topic 1

o Slides 6-8  Content for topic 2

o Slides 9-11 Content for topic 3

o Slide 12 Conclusion

Corporate image

When creating an electronic presentation, speaker notes or an audience
handout, you need to be aware of your organisation’s preferred style.

There may be particular requirements you have to follow. For example, you may have to
include the company’s logo in the top left-hand corner of the slide or in the banner on the
bottom of each slide and use the company’s corporate colours throughout the presentation.
Many organisations require a particular look for the material they produce. By using a
specific design layout, this will create a consistent and professional image that is instantly
recognisable to clients and others outside the organisation.

Companies often have a range of different logos and variations on the designs for specific
purposes, or for special areas of their company’s activities. You may need to discuss this
with someone from the marketing and communications department to check which

style is appropriate for use in a particular circumstance or for a certain audience, such as
external clients. Style can also relate to sounds, music and overall content. All of these must
align with the chosen corporate image and create a clear message to the audience about
company values.

Organisational style guide

An organisational style guide will provide you with the specifications,
instructions and design details for the format and final look of your
presentation.

The purpose of the organisational style guide is to ensure consistency in the presentation
and any documents produced by the organisation. This may include using standard
templates or using the corporate letterhead or logos in appropriate places in your
presentation.

Style guides may also outline rules for the type of words that are used in the document. For
example, acronyms and jargon may be appropriate for internal review by managers, but may
not be appropriate if the document is to be presented to customers or the general public.

In many cases, if a standard template is used, predefined styles will automatically appear in
the document. Clarify the use of style guides for your organisation with your supervisor and
colleagues.
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Presentation templates may include layout and design information such as:

¢ Header and footer size

¢ Heading details such as type and size of font

¢ Colour schemes

e Maximum or minimum font size

* Recommended font types

* Spacing of text and paragraphs

* Specific layout designs

¢ Location of company logo and slogans, or other information such as version numbers

e Specifications on imported video

* Use of images, including sizes and dimensions

Jenni has recently been employed as a marketing assistant for an ad agency called
Impact. The company often uses presentations to communicate the requirements for its
clients’ marketing campaigns to the various teams. Jenni will use the standard templates
to prepare for a meeting, but she will need to change the colour scheme to reflect the
corporate colours of the client.

Here is a sample of the electronic design requirements contained in the template that
Jenni will need to use:

The company logo should appear on the top left.

The date should appear on the bottom right.

One heading should be used per slide.

All headings to be Arial and all body text to be Times New Roman.
All headings to be bold and in font size 24.

All body text should be in font size 16.

There should be approximately three bullet points per slide.

Use square bullet points.

Images must reflect and promote the content.
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Practice task 4

Explain why it is important that you find out information from your supervisor in relation to the
following before you begin a task:

a) The purpose of the spreadsheet

b) The intended audience

Question 2

Explain why organisations have style and layout guides for electronic presentations. Provide an
example for each of the following style elements:

e company logos

e version control

* bullet points for content
* headings.
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Work to a deadline

Whenever you are given a work task, you need to determine a time line for its
completion.

A time line is a plan for how long a task will take

to complete. It also breaks the task into steps and
details when each step needs to be completed by.
Using a diary system and a to-do list can help you
to prioritise tasks and keep on top of the time lines
required for set tasks. For example, you may have to
print hard copies of the handouts the day before the
presentation so they can be delivered to the venue,
or your organisation may require you to book in

a printing job that may take a couple of days to be
completed, e.g. printing double-sided and in colour.

In many cases, time lines are set and agreed with
your stakeholders:

 Internal stakeholders are those that work at the same organisation as you, and may
include colleagues in other departments, managers and supervisors.

o External stakeholders are those that are outside the organisation, including customers
and suppliers.

Often your manager or supervisor will give you a deadline for completing a set task (e.g.
prepare a draft letter by 2pm). Alternatively, you may have deadlines for completing regular
work tasks, e.g. completing a monthly sales report or sending letters to customers who are
overdue in paying an invoice by a certain number of days.

Meeting a deadline demonstrates your competency and professionalism in undertaking
tasks. Make sure that when deadlines are set, they are both achievable and realistic.

If you have concerns that a deadline might not be met or you have conflicting work
priorities, discuss this with your manager or supervisor as soon as possible. They may be
able to assist you by suggesting how the deadline can be met or agreeing to adjust the time
line for the task.

Preparing presentations will become less problematic once you are familiar with the
requirements of your organisation.

The following table is an example of a useful planning checklist.

Task Deadline Requirements Tick when
completed
Prepare an 10 May ¢ Follow order outlined in storyboard.
electronic  Use organisational style guide
presentation including company logo and colours
for Kyle for the in headings and banners.

board meeting.
g e Use Arial bold for headings and

Times New Roman for body text.
e Draft ready by 7 May for rehearsal.

e Print 17 copies of handouts after
final review.
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Practice task 5

Describe the steps you would take to prepare a presentation.

Question 2

If your manager made some new demands at the last minute, what might be the effect on your
work?

Question 3

Explain how using a checklist can help you deliver an electronic presentation on time.
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2 B Use software functions

To design a professional and interesting presentation, you need to learn about
the various software functions and features available to you.

This will enable you to prepare a presentation that
has a consistent style and visual impact.

Here are some of the skills you will be able to
perform in PowerPoint:

« create a slide show

« apply a design template

o add content to slides

o write or draw on slides

« apply a style to slides

» create handouts and speaker notes.

PowerPoint functions

Before you start to design your presentation, you should become familiar with
some key PowerPoint functions.

PowerPoint uses slides to build an electronic presentation. A slide is a single frame in a
presentation, and a presentation comprises a group of slides. Look at the functions and
descriptions outlined here.

Placeholders

Boxes with dotted lines that appear when you create a new slide. This is where
you add your content.

Slide master

Allows you to change the style of text and have the style reflected throughout the
whole presentation.

Notes master

K Allows you to create notes when working on your presentation.
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Importing

Allows you to import information from other applications such as Microsoft Word
or Excel, as well as images or graphics.

Colour schemes

Provides a selection of background colours that you can apply to your
presentation.

Templates

Contain colour schemes and text formatting to design a presentation with a
particular look. You can alter the colours and text formats chosen within the
template itself to customise these.

Hyperlinks

Allows you to create a link in the presentation to another slide in that same
presentation, or to another software file or website.

Avoid distractions to improve readability

It is easy to overuse many of the features and functions available in PowerPoint
software.

If your electronic presentation is too busy;, it can distract your audience from the content
and message you are trying to communicate. Try to keep the presentation clear, concise and
easy to view on the screen. Your handouts should reflect the content in the slides and can
expand on information where necessary.

The font size used in a presentation is larger than the font used in a regular Word document
to allow people to view it from a distance. Projecting the slide show onto a wall or screen or
allowing the viewer to watch the show on a screen allows for a good size magnification. This
will improve the readability of content.

If the content of your presentation is ‘heavy going’ for your audience, e.g. it has a large
amount of words and details, you can help to break up the content with an occasional light-
hearted slide, such as a cartoon or quote relevant to the subject being delivered, or a high-
resolution image, chart or diagram. This will enhance the readability and help maintain the
interest level of the participants. Always keep the individual and group needs in mind when
making design decisions. For example, consider whether there are any people with disability
or cultural issues that should be considered when delivering the presentation.
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Avoid the following distractions to improve the readability of your presentation.
Distractions may include:

* heavy colour

* not enough colour contrast between the main text and the background

* distracting animation of words or illustrations

* irrelevant illustrations

* multiple transitions either within a slide or throughout the whole presentation
* overly busy or dominant backgrounds

* overuse of sound

* too many words or pictures per slide

* too many small or varied fonts.

Practice task 6

Use PowerPoint to create a slideshow for your presentation by following these steps.

1. Open ablank presentation in PowerPoint. Select a layout for your slide by selecting the
Layout drop-down menu in the Home tab. The option below is for a title and subtitle to
be used.

2. To add content, simply click inside the placeholder (rectangular box) and enter the text
you want.

Click to add title

Click to add subtitle

3. To add additional slides that you need for your presentation, click New Slide in the
Home tab.

Unit release 1 (Aspire Version 1.1)

40 © Aspire Training & Consulting



Topic 2
Create presentations

4. To style a slide, select the Design tab and choose the slide style best suited to your
organisation and the content.

5. Save your presentation using a suitable name.

Applying and creating templates

Templates store design information that you can apply to a presentation to
consistently format the content on all slides.
When you create a template in PowerPoint you create a .potx file that captures any

customisations you make to a slide master, layout and theme combination. Below is an
example of a template.

Contemporary Photo Album

This template contains placeholder content ‘Contemporary Photo Album’. It also contains
formatting, colour, background and layout features.

Each template contains a slide master that must have at least one layout (but can contain
more) for you to use in a presentation. While the preceding template was created by a
designer, you can create a template by creating one or more masters, adding layouts, then
applying a theme.

To create a template, go to the Design tab. If you want to use a default slide master, choose
one from the designs shown at the top of the screen.

If you want to add another slide master or create a new slide master, refer to PowerPoint help
menu search feature by typing ‘create a new slide master’ into the space next to the lightbulb
icon. This will take you to this topic and other relevant topics with instructions to follow.

Q Tell me what you want to do

Apply a layout by using the standard layouts that are built into PowerPoint 2016. If you want
to customise your layout, refer to ‘layout’ in the help menu.

Once you have finished creating a template, go to the File tab, and then click Save As.
Choose where you want to save the file. In the File name box, type an appropriate file name.
In the Save as type drop-down menu, click PowerPoint Template, then click Save.
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Background styles
Background styles are background fill variations from different combinations
of theme colours and background intensities in the current document theme.

Theme colours, theme fonts and theme effects make up a theme background. A theme may
be applied to a file as a single selection.

Click on the relevant slide to add a background style to your presentation. To select multiple
slides, click the first slide on the left, then press and hold Ctrl while you select the other

slides.
O S
- mmms : Slide Format

Size ~ Background

Variants Customize

In the Design tab, click the arrow in the Variants group to open the drop-down menu.
Hover over to Background Styles to view the options.

oy Y}
N |
r—

Right-click the background style you want, and then do one of the following:

o To apply the background style to the selected slides, click Apply to Selected Slides.

o To apply the background style to all of the slides in your presentation, click Apply to All
Slides.

To replace the background style for the selected slides and any other slides in the
presentation that use the same slide master, click Apply to Matching Slides. This option is
available only when your presentation contains multiple slide masters.

LI ——— bt

o | e Y G . 2

Click to add title

Cick 1o ogd tex!
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Practice task 7

Take the following steps to add content to your presentation.

1. Open your presentation and select the Home tab. Select the title slide. Click inside the
placeholders and add a title and subtitle.

2. Ifyou have chosen to use a title page with a graphic, select a suitable graphic via the
Insert tab. There are various options available for inserting images and graphics. For
example, you can select the Pictures icon to insert a picture saved on your computer or
click Online Pictures to search for particular types of pictures.

3. Go to each of your slides by clicking on the thumbnails and add the content. You
might also like to insert a graph by using the Chart icon or format content by clicking
SmartArt and selecting from the options.

4. View your presentation by going to the Slide Show tab, then click From Beginning. In
this view you can see the slides as they will appear in your presentation. To move from
slide to slide, you can press Enter, the Spacebar or an arrow key, or simply left-click
your mouse.

5. Ifyou want to change the sequence of your slides, click View, then Slide Sorter. This
view allows you to see all your slides at once. You can click on and drag slides into a
different sequence.

6. Save your presentation.

Here is an example of a slide displaying a title, content, graphics and a standard design
template.

Management

training Mm

presentation

nan
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Write or draw on slides

When you are playing your presentation you might like to circle, underline,
draw arrows or make other marks on the slides to emphasise a point or show
connections.

To write on slides during your slide show, select the Slide Show tab and click From
Beginning to start your presentation. Right-click the slide that you want to write on. A
drop-down menu will appear. Go to Pointer Options, and select either Pen or Highlighter.
Hold down the left mouse button and drag to write or draw on your slides.

You can change the pen or highlighter colour by right-clicking the mouse and hovering over
Pointer Options, then Ink Color. Select a colour of your choice.

Company Logos

What you see is whot you get

To remove some or all of the pen or highlighter, right-click the slide and go to Pointer
Options to select either Eraser or Erase All Ink on Slide. From here you may also hover
over Screen and select Show/Hide Ink Markup.

To turn off the pen or highlighter, right-click the slide, go to Pointer Options and click
the Arrow.

At the end of the slide show presentation, you will be prompted to either keep or discard
the changes you made using a pen or highlighter. Choose one of the options to exit the
slide show.

Apply a style

Once you have added the content to your presentation, you can apply a style.
This will ensure the format is consistent throughout the whole presentation.
To apply a style, you will need to use the Slide Master. The Slide Master is similar to a

template. It allows you to choose a style and format the text. These choices will be reflected
throughout the whole presentation.

You can also modify the header and footer on the Slide Master to include text, slide
numbers and the date and time. There are placeholders for each of these elements.
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Practice task 8

To apply a consistent style to your presentation, follow these steps.

1.
2.

Select the View tab, then click Slide Master.

Click on the top placeholder to add a heading. This will be the heading on all subsequent
slides. However, you can still edit it if necessary when you switch to Normal view.
Choose formatting to suit your title from the Format tab. By hovering over different
WordArt styles, you can see the impact the style will have on your title. Select a style.

Click on the second placeholder and add text. Choose formatting to suit your text from
the formatting toolbar. If you have written different levels of text, choose formatting to
suit all levels.

To view your choices, select the View tab, then select Normal. If you are unhappy with
your choices, go back and alter them.

To add footer information, select the Insert tab, then select Header & Footer. Tick the
Date and time checkbox. The Update automatically button will be selected. This will
make sure that the date and time on your presentation is always correct.

Tick the Footer checkbox and click inside the box to add a suitable footer for your
presentation. Click Apply to All.

View your new style by going to the Slide Show tab.
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Practice task 9

Read the case study, then complete the task that follows.

Case study

You have recently been employed as a marketing assistant for an organisation that manages
marketing campaigns and provides marketing and promotional advice to clients.

The marketing manager has asked you to prepare a presentation for the marketing team, which
consists of 10 staff from four different areas of the organisation. The purpose of the presentation is
to communicate a marketing plan that has been developed for a client.

Your manager has provided you with the following information that needs to be included:

description of the product and the variations in the range, including its special features, logo and
corporate colours

sales analysis figures for the last five years in an Excel spreadsheet
characteristics of existing and potential customers

description of the competitors and their market share

market research outlining current market industry trends and market share
marketing budget

marketing strategy, including an advertising plan and promotional plan
pricing strategy

schedule of tasks with allocation of responsibilities.

Develop a storyboard to plan the presentation, ensuring that all information will be covered.
The presentation should be no more than 20 slides.

46

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



Topic 2
Create presentations

2C Add balance and visual impact

PowerPoint has many features that allow you to add visual impact and
emphasis to certain parts of your presentation.

It is important to find the right balance when
choosing the type and number of features to use.
They can easily be overused and distract from
the information you are trying to communicate.
However, when used in the right way, they

can create visual appeal and draw attention to
important information.

Here are descriptions of several different
presentation features.

Transition

This controls the way slides are presented. For example, they might enter from the left
or the right of the screen.

Animation

This defines how content on the slide is presented. For example, text can fly into or
dissolve on the slide.

Graphics

Images, charts, diagrams or photos can be inserted to add colour and visual impact.

Timing and pace

You can automatically control the transition time between each slide or when certain
animations will occur.

Music, sound and video

Video and audio files can be added to enhance a presentation.
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Slide transitions

Slide transitions are the effects that occur in Slide Show view when you move from one slide
to another. You can control the speed of each slide transition effect, and you can also add

sound when changing slides.

PowerPoint includes many different types of slide transitions, including:

* No transition

e Blinds vertical

* Boxout

* Checkerboard down

Blinds horizontal
Box in
Checkerboard across

Comb horizontal

e Comb vertical

To add a slide transition, go to the Home tab and select a slide thumbnail (ensure you are in
Normal View).

Select the Transitions tab and choose a slide transition effect.

To set the slide transition speed, in the Timing section, change the settings in Duration to
increase or decrease the speed.

Click Apply to All to add the same slide transition to all of the slides in your presentation.

To add different slide transitions to the slides in your presentation, repeat these steps for
each of your slides.

To add sound to slide transitions, click the arrow next to Transition Sound. To add a sound
from the list, select the sound that you want. To add a sound not found on the list, select
Other Sound, locate the sound file that you want to add, then click OK.

To add different sounds to each slide transition, click on each slide and select a sound from
the drop-down menu.

Adding graphics and illustrations

You can easily insert photos from file or online pictures, shapes and charts.

Graphics can be included in your presentation by
selecting the Insert tab and choosing from the
Images and Illustrations groupings.

You can also use a feature called SmartArt

to include graphics in your presentation. A
SmartArt graphic is a visual representation of your
information that you can create quickly and easily,
choosing from among many different layouts, to
effectively communicate your message or ideas.
For example, you can insert hierarchical charts,
pyramids or arrows with text.
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To add an illustration, go to the Insert tab and click SmartArt.

@Dll

Shapes Icons SmartArt Chart
v Models'

Illustrations

In the dialog box, click the type and layout you want. You can enter your text either by
clicking a shape in your SmartArt graphic and typing in your text directly or by opening
the Text Pane from the Design tab under SmartArt Tools. The text you enter for each bullet
point will appear in different parts of your SmartArt graphic.

Animation

Apply animation sparingly to prevent obscuring your message or
overwhelming your audience.

You may wish to add animation to your SmartArt graphic to draw the viewer’s attention or
stimulate interest. For example, you can make a shape fly in from one side of your screen or
slowly fade into view.

To decide which animation works best with the layout of your SmartArt, view your
information in the SmartArt graphic Text Pane, since most animation starts at the top of
the Text Pane and moves down. You can also play an animation in reverse order.

The animations that are available depend on the layout you choose for your SmartArt
graphic.

To animate your SmartArt graphic, click on it and go to the Animations tab, then select the
animation you want to apply. You can customise an animation using Effect Options in the
Animation section. Here, you can choose to animate all of the shapes in the SmartArt at
once or one shape at a time.

To add sound, go to the Animations tab and select Animation Pane. A panel will appear on
the right. Click the arrow next to it and select Effect Options from the drop-down menu.

In the dialog box, click the arrow next to Sound, then either select a sound from the list or
select Other Sound... to locate a sound file on your computer.

Animated items are noted on the slide by non-printing numbered tags. These tags
correspond to the animations in the Animation Pane, which appear only in Normal view
with the Animation task pane displayed.

You can view your animations at any time by going to the appropriate slide and clicking the
Preview button in the Animations tab.
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Timing and pace

The timing and pace of a presentation are important to get right.

You may choose to manually control how the slides ¥
and content of your presentation will be displayed.
Alternatively, you can pre-set the time and pace
using PowerPoint. Using this function, you can have
slides that appear after a certain amount of time

has passed. The amount of time you set will depend
on how much information is contained in the slide,
and how much emphasis you want to place on the
information.

It is a good idea to rehearse your presentation to
ensure it meets the required time frame. To do this,
you can record the time that you need to present
each slide, then use the recorded times to advance
the slides automatically when you are actually giving the presentation.

To do this, go to the Slide Show tab, then click Rehearse Timings. The Rehearsal toolbar
will appear, and the Slide Time box will begin timing the presentation.

Recording v X
= ] 0:00:06 € 0:00:06] «—— Total time for presentation

bttt

Next Pause Slide Time Repeat

While you time your presentation, you can take the following actions:
« To move to the next slide, click Next.

« To temporarily stop recording the presentation, click Pause, then click Pause again to
continue recording.

o To restart recording the time for the current slide, click Repeat.

After you set the time for the last slide, a message box will display the total time for the
presentation and prompt you to do one of the following:

o To keep the recorded slide timings, click Yes.

o To discard the recorded slide timings, click No.

The Slide Sorter view will then appear and display the time recorded for each slide in your
presentation.

If you do not want the slides in your presentation to advance automatically by using the
slide timings that you recorded, you can turn the slide timings off by going to the Slide

Show tab and deselecting the Use Timings checkbox. You can turn the slide timings on
again by ticking this box.
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Music, sound and video

To make a multimedia presentation you can add music, sound or video.

These can be added from files on your computer.
Ensure speakers are properly set up to be able to
play sound and music in your presentation.

To add music or sound, view the presentation in
Normal view. Go to the Insert tab and select Video
or Audio from the Media group.

Video may be located either online or on your
computer. You can choose to either record your own
audio or to insert it from your computer.

Once you have inserted a video, a message

will be displayed. If you want the video to play
automatically when you go to the slide, click Yes. If
you want the video to play only when you click the
video icon during a slide show, click No.

Practice task 10

Are the following statements true or false? Tick the relevant column beside the statement.

True False

A transition is the style used to move from one slide to another. D D
The same transitions must be applied to all the slides in your
presentation.

Examples of graphics that you can insert into a presentation are
photos, shapes, cartoons and charts.

You can insert hierarchical charts, pyramids or arrows with text using
SmartArt.

You can never have enough animation because it adds interest to your
presentation.

Your presentation must be in slide view before inserting sound or video.

Presentation features such as colour, movement, video, sound and
animation add more dimensions to the presentation beyond talking and
text dot points.

You create a multimedia presentation when you add music, sound or
video to your presentation.

I O ) O B O
I O ) O B O
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2 Use advanced features to customise for the

audience

By using the advanced software features in PowerPoint, you can streamline and
customise your presentation to meet the needs of several different audiences.

Advanced software features include basic and
hyperlinked custom shows. Custom shows allow
you to adapt a single presentation for a variety of
audiences. You can use a custom show to present or
create a hyperlink to an independent group of slides
in your presentation.

A basic custom show can be a separate presentation
or a presentation that includes some of the slides
from another presentation. A hyperlinked custom
show provides a quick way to navigate to one or
more separate presentations.

The custom shows feature gives you the flexibility
to choose which sections you present to which
audience type without having to create totally separate versions of your presentation.

Here are some examples of how the custom show feature can be used.
Custom show features for different audiences

e One group requires only brief introductory information and then the advanced
information at a later date.

* One group requires an extended version of the introductory information, before
proceeding onto the advanced information.

* One group requires additional supporting material, such as details on charts or data.

Custom shows

You can use a custom show to give a more targeted presentation to different
groups of people.

For example, if your presentation contains a total of five —
slides, you can create a custom show named Custom

1 that includes just slides 1, 3 and 5. You can create a

second custom show named Custom 2 that includes siides foi
slides 1, 2, 4 and 5. When you create a custom show
from an original presentation, you can always run the
entire original presentation in the correct order.

(i Slides for

CUStOm ] / Custom 2

You can use a hyperlinked custom show to organise 1=
content in a presentation.

oOooo

For example, if you create a primary custom show about your company’s new overall
organisation, you can then create a custom show for each department within the
organisation and link to this show from the primary presentation.
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You can also use a hyperlinked

custom show to create a table of

contents or agenda slide. This is

similar to a webpage in that it is an

index of your presentation from Primary

which you can create hyperlinks showawith
and move between the different

sections of your presentation and

back again.

<— Custom A

/DD
(][]

f 2

<— Custom B

To create a custom show, go to
the Slide Show tab and click
Custom Slide Show, then select
Custom Shows.

Wiwf]
(][]

In the Custom Shows dialog box, click New. Under Slides in presentation, select all the slides
that you want to include in the custom show, then click Add.

To change the order in which slides appear, under Slides in custom show, click a slide, and
then click on the arrows to move the slide up or down in the list.

Type a name in the Slide show name box, then click OK.

To preview a custom show, click the name of the show in the Custom Shows dialog box, and
then click Show.

To preview a custom show, go to the Slide Show tab and click Custom Slide Show. Then
select the name of the custom show from the drop-down menu.

You can also click Set Up Slide Show. In the dialog box under Show slides, click Custom
Show, and then click the custom show that you want to present. Click OK. The custom show
you have selected will now be presented when you play the slide show.

Practice task 11

Take the following steps to create a hyperlinked custom show.
1. Open or create a presentation with a minimum of five slides.
2. Select the Slide Show tab and click Custom Slide Show, then select Custom Shows.

3. Select New and, under Slides in presentation, tick the title slide and three additional
slides, then click Add.

4. Arrange slides in the order you desire by using the arrows to move the slides up or
down.

5. Next to Slide show name, type ‘Custom show 1’, then click OK.

6. On the title slide, type ‘Go to custom show’. Select the textbox and click on the Insert
tab, then click Link.

7. In the dialog box, select Place in This Document. Select ‘Custom show I’ from the
menu, then tick the Show and return checkbox and click OK.
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2 E Overcome issues using help functions

You may experience problems when producing an electronic presentation.

For instance, you may find it difficult to use or
locate a particular software function, and may not
know who to ask.

It’s a good idea to have a plan for dealing with the
unexpected. Organisations deal with difficulties
in a number of ways. They might have manuals
or training booklets. Some may even have an IT
helpdesk or support staff to assist employees.

Using help functions

If you require information or instructions on how to do something, you can
hover over different icons with your mouse or seek assistance in help.

You can use help for a variety of reasons, g
depending on your needs. You might want tips PowerPoint Help -
on using your keyboard or your mouse. Or you DD G G X | tooch v nen 2

might want information on using the features

Need assistance?
of the program more effectively.

Use the search DOx to tell us whal you re lookang for and we'l do
ol best to find an anawer.

Microsoft PowerPoint 2016 provides a
description of each icon or function on the
screen which can be displayed by hovering over
the icon.

Alternatively, you can ask for help at any time
by pressing the F1 key or by using the search
box. Simply type in the keyword or phrase that
you need help with in the search box at the

top of the screen, and a list of options will be
displayed to choose from.

You can navigate the help window in the same way you would navigate the internet in a web
browser, by clicking hyperlinks to different pages.

Taking screenshots

It can be helpful to take a screenshot to communicate the issue you are having
to someone else.

A screenshot captures the image of your computer screen in its current state, including
any error messages that are being displayed. If you are having a particular issue with your
computer that is difficult to describe, it can be useful to take a screenshot and send this
image in an email to the IT department or a colleague who may be able to assist.
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To take a screenshot, press the print screen icon on your keyboard. This may be displayed as
an abbreviation, such as ‘PrtScn’. Then simply insert the image into an email by pressing
Ctrl+V on the keyboard or by right-clicking the mouse and selecting Paste from the drop-
down menu.

If you are using two screens, the image will show both of your screens. You may E
need to crop part of the image to focus on the issue you are having, such as an ====
error message. To do this, click on the image and under the Format tab, select Crop
Crop. Then you can simply drag the edges of the image in to focus on the issue. -

Manuals and training

Most software comes with a user manual which describes the features and
provides step-by-step instructions for its use.

Manuals include information about functions of the
software and on maintenance, use and any health
and safety issues related to equipment needed to use
the software. Manuals can come in a paper-based or
online format.

There are many websites that have information
about Microsoft Office applications. These usually
contain frequently asked questions (FAQs) and
give solutions to common problems. You can

also download updates, tools and any fixes that
Microsoft has developed for its software problems.

http://aspirelr.link/microsoft-support

This is Microsoft’s main site for finding help to solve problems for all Microsoft products. You
can ask questions online and download files, including service packs, drivers and patches.

http://aspirelr.link/microsoft-office

This site provides resources for all Microsoft Office applications. It has news and
announcements, as well as useful files that you can download. If you are connected to the
internet, you can open this site by selecting help in any Office application. You may need to
click on the bottom right of the window to allow access to Office.com.

Another resource you can refer to is training material. Training courses usually provide a
comprehensive set of instructions or notes that are worth keeping for future reference.

You may have been to a training course to learn a particular computer function or you may
have received training or induction materials when you started a new job.

You may need to refer back to your training notes whenever you need help with a specific
program or function.
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Help for overcoming issues

Mohana works as a personal assistant to a manager in a large organisation. One of her
roles is to produce PowerPoint presentations based on content and information provided
to her by her manager. Mohana often refers to the help functions to assist her in making
the most of the software and as a way of increasing her skills. If she is unaware of what a
screen icon’s function is, she hovers over the icon with her mouse and reads the bubble
displayed.

Sometimes Mohana uses Microsoft’s support website to find solutions to software
problems that cannot be solved using the help function. There are manuals available in
Mohana’s workplace and she has photocopied the pages she refers to most frequently.
She also keeps electronic copies in a help folder on her desktop.

A couple of times she has not been able to find the information herself, and has needed
to ask her colleague Lauren for help. Lauren is always happy to help and offer advice and
new ideas for how to do something.

9
Q.
£
©
>

"

Practice task 12

Imagine you have forgotten how to apply transitions to slides and you need a reminder to get you
started. What would you do? Where would you go for assistance?

Question 2

Outline the steps you would take to solve software problems when producing an electronic
presentation.
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Summary

An organisational style guide outlines a preferred style, such as inclusion of a logo or
corporate colours. It is important the audience is not distracted by unnecessary features.

Use a diary system or checklist to help you to prioritise tasks and keep on top of the
time lines required for set tasks.

An interesting presentation will include visually attractive features to add impact and
emphasis to the content, such as graphics, sound and transition options.

If your electronic presentation is too busy, it can distract your audience from the content
you are trying to communicate.

You can streamline and customise your presentation to meet the needs of several
different audiences with basic and hyperlinked custom shows.

Make sure you are familiar with how to access help and assistance if you encounter
problems to avoid delays in preparing your presentation by the due date.

Use paper-based user manuals and training documents as well as online help material to
overcome problems when producing electronic presentations.
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Learning checkpoint 2

Create presentations

Part A

Read the case study, then answer the questions that follow.

Case study

Claire was told to prepare an electronic presentation to show to external clients. She knew that
the clients wanted information about new legislation and how it was affecting the organisation.
She found lots of legislative documents and used the details to fill the slides that made up the

presentation.

Claire found a PowerPoint document on the company’s database dated from the previous year that
had a similar title. She deleted the existing information and then updated the document with the
information she was given. Claire noticed this was an older version of Microsoft PowerPoint and she
wasted a lot of time trying to find the particular features and functions because she was unfamiliar
with this older version. Claire then produced speaker notes that contained additional, detailed
information.

Claire was under pressure trying to complete the presentation in time for the session with clients.
She was planning to do a trial run and practise the presentation in the hours leading up to the
meeting. However, there were problems with the technology and getting an internet connection for
the hyperlinks. In the end she didn’t get these to work and so decided to talk through these slides
rather than showing different websites for legislation.

When Claire delivered her presentation, the audience seemed confused and some clients appeared
to fall asleep. She later found out the audience wanted a general outline of the legislation and the
details she presented to them on the slides and in her notes were too complicated. Her supervisor
was unhappy because the style and layout used for the slides showed an outdated version of the
company’s logo and corporate colours.

1. Describe three things Claire should have done before producing the presentation to
avoid the issues that occurred.
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2. Describe three presentation functions Claire could have added to her presentation to
make it more interesting to her audience.

3. Why was Claire’s boss disappointed that she didn’t use the style guide and
recommended template for her presentation?

4. How could a custom slide show have been useful to Claire?

5. Where could Claire have accessed some help when using the older version of
PowerPoint?
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6. Give three examples of what Claire could do to improve the readability of the
presentation.
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The quality and content of your electronic presentation reflects the
professionalism of your organisation.

To complete a professional presentation to a high standard, you need to ensure that your
presentation is carefully proofread and that all associated printed materials are accurate and
informative. They need to be checked to make sure they meet style and layout specifications.

You need to allow time to edit and proofread before they are printed, published or
distributed. You may need to check style and layout specifications and look out for spelling
and grammatical errors.

Electronic presentations need to be saved and stored securely to eliminate the possibility of
loss or damage of data and information. There are several methods of ensuring safe storage.
In this topic you will learn how to:

3A  Proofread your presentation

3B  Finalise and print your presentation

3C Store your presentation
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3 A Proofread your presentation

Your presentation needs to be checked for spelling, grammar, consistency and
style.

Although you might write the text in your presentation very carefully, there will probably
still be some mistakes. It is better to find these during a rehearsal than in front of an
audience. You can proofread your work by closely reading it yourself first, then getting
someone else to read it.

Editing is also used to check that documents meet organisational layout requirements, and to
identify and correct errors in grammar, punctuation and spelling.

Remember to clarify instructions if you are unsure and ask about what else may be needed
in the document. If you have your own ideas on how the content or format could be
improved, discuss these with your supervisor.

Spelling T\

Never rely entirely on the spell-check function on your computer. It only identifies
spelling errors, not words that have been used incorrectly. Words may also be
spelled in different ways; for example, American and Australian spellings of
words such as organize/organise. Check your organisation’s style manual or ask
your manager if you are unsure.

_/

Grammar

Grammar and punctuation suggestions made by software applications are not
always correct. Check them yourself before accepting the suggested change.

Style

Style should be consistent throughout the document. Make sure headers and
footers are correct, and that the font is consistent throughout. Check your
organisation’s style manual or ask your supervisor if you are unsure.

Numerical data

If you are working with numbers, match your document with the original figures
you were given and make sure they are accurate. It is easy to make a mistake
when entering a lot of numerical data into a document.

- J o J
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Spelling and grammar check

PowerPoint is equipped with an internal dictionary that can help you correct
words that are misspelled in your presentation.

As well as checking spelling, PowerPoint can also check style to make sure that each slide
is consistent. Check with a colleague or supervisor to determine the requirements of your
organisation. Then, make the necessary alterations to the style of your presentation. Your
colleague may be happy to read over your presentation and offer some advice on grammar
or identify spelling mistakes that were missed.

To check the spelling and grammar of your presentation, open your presentation and select
the Review tab from the ribbon. Click on the ABC Spelling icon at the top left of the screen.

When a word is misspelled or mistyped, a wavy red line appears under it to alert you to the
mistake.

To correct a misspelled word, right-click a word that has a
wavy red underline. If the word appears in the drop-down aliquant
list, click the word that you want to replace the misspelled

aliquot
or mistyped word with. it
If a red wavy line appears underneath a word that has been < o
spelt correctly, it is not in the built-in dictionary. To add aliquots
it to the dictionary, right-click the word and select Add to
Dictionary. clique
To turn the automatic spelling and grammar check on or Ignore All

off, go to the File tab and click Options. Click Proofing.
Under When correcting spelling in PowerPoint, tick the

checkbox next to Hide spelling and grammar errors, then
click OK.

| PowerPoint Options ? X

Add to Dictionary

iy B¢
b y v ."v.l’n.]l' how PowerPoint corrects and formats your tead
| Procfing \

Austal arrect oplioe
hange how PowerPuwd cornects and formats text as yuu type AutoCorect Optons

When coere ting wpefing in Microso!t (1 i e progeams

Tradtional and new spefings =

wteo verb forms only

When correcting speling in Power Paint

[I] Cancel
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AutoCorrect

The AutoCorrect function in PowerPoint 2016 is a default setting of common
misspellings and symbols, which you can modify.

This feature corrects typos and misspelled words, and inserts symbols and other pieces of
text. Text included in hyperlinks is not automatically corrected.

The AutoCorrect feature also includes a series of parallel lists, where a particular word typed
can be automatically replaced by another word.

For example, the AutoCorrect feature can be used to:

« automatically correct typing errors and misspelled words; for example, if you type ‘teh’
instead of ‘the’

« insert symbols; for example, you can type :-) to insert a smiley emoji.

To adjust AutoCorrect settings, go to the File tab and select Options. Click on the Proofing
tab and select AutoCorrect Options. Here you can add, delete and amend AutoCorrect
options.

To add an entry to the list of automatic corrections, select the AutoCorrect tab. In the
Replace box, type a word or phrase that you often mistype or misspell (e.g. ‘usualy’). In the
With box, type the correct spelling of the word (e.g. ‘usually’). Click Add.

AutoCorrect: English ? X

AutoCorrect  AutoFormat As You Type Actions Math AutoCorrect

Show AutoCorrect Options buttons

Correct TWo INitial CApitals
Capitalize first letter of sentences
Capitalize first letter of table cells
Capitalize names of days
Correct accidental use of cAPS LOCK key
Replace text as you type
Replace: With:

usualyl usually

Exceptions...

unpleasently unpleasantly A
untilll until
useing using

usualyl | usually

veyr very v

Replace Delete
Automatically use suggestions from the spelling checker
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Practice task 13

Look at the following slide, then complete the tasks that follow.

Soar Throats

Coursed by:

«» contagius Virusess,

« Infraction in tonsilis

« Bactaria such As strepp throat

« Alegory from polan or cats and dog's

Proofread the slide. Check for spelling, grammar, punctuation and consistency of style. Rewrite
the slide, amending it to include your corrections.

Question 2

Why shouldn’t you rely on spell check to identify spelling mistakes in your presentation?
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3 B Finalise and print your presentation

Hard copies are useful for the presenter to refer to while they present the slides
to a group.

You can print handouts, notes or outlines. You
need to decide on the appropriate materials for
each presentation and have the printed copies
available within the designated time line. If you
want to customise these presentation materials for
yourself or another person (e.g. by adding headers
and footers), you can use the Handout Master
and Notes Master before printing the materials.
Remember that if you add information using the
master, it will only appear on the printout, not on
your slides.

Discuss what the presenter requires before printing,
as alterations may be required. It is better to do the
final corrections and alterations at this stage before going any further and printing multiple
handouts or having the presenter find mistakes at the last minute.

You may also need to assemble other presentation materials, such as:
« outlines of the session for distribution
« additional information for use, such as printouts from a website or handouts.

Creating handouts

PowerPoint allows you to create audience handouts that can be viewed, edited
or printed along with a presentation.

Handouts are basically thumbnails of slides ™ Voa/amns
printed together in a hard copy that can

be given to participants in a face-to-face

delivery.

Handouts can be customised to suit specific
requirements to make them consistent. Just
as the Slide Master is used to make the
style of your slides consistent, the Handout
Master is used to add information to your
handouts. This will then be reproduced on
all of the handouts in your presentation.

Keep in mind that the information you add
using the Handout Master will only appear
on your handouts, not on your slides.

Go to the View tab and select Handout
Master. You will see a template displaying
blank outlines of your slides.

foster -
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In the handout template area there are four editable regions (on the four corners of the
page). These include:

o header area
o footer area
o date area

o slide number area.
Click on the header area. The placeholders will be displayed.

To see more clearly, use the zoom function in the bottom right-hand toolbar to zoom in.
E == B T -—F—+ 100% (J

Enter a suitable header for your presentation. Enter relevant information in the Date, Footer
and Number areas.

The information you have entered on the Handout Master will appear on all handouts you
print for your presentation.

Printing handouts

In PowerPoint you can print your slides as handouts for the audience.

You can also choose how many slides you would
like on each handout. Consider the readability and
function of the handouts. For example, if you print
the maximum number of slides per page, there

will be little room for notes. The readability of the
information may also be affected as the font may be
too small to read.

To print out an exact replica of your presentation
slides, select the File tab and click on the Print

tab. Click on the second drop-down menu under
Settings to choose a handout layout option to print.

For example, the 3 Slides option under Handouts
provides three slides on each page with lines for the
audience to take notes.

To specify the page orientation, select the fifth drop-down menu under Settings. Here you
can choose either Portrait Orientation or Landscape Orientation.

If you want to print handouts in colour, select a colour printer from the drop-down menu
under Printer. Then select the last drop-down menu under Settings and click Color. Select
Print to print the handout notes.
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Creating and printing speaker notes

1.

Speaker notes are designed to help the presenter outline any additional points
or information they would like to discuss, which may not be included in the

slides.

If you add speaker notes to your PowerPoint presentation, you will be able to deliver the
presentation smoothly, without worrying about forgetting the main points. By selecting
Notes Master in the View tab, you can add header and footer information to your notes as

you did with the Handout Master.

To add notes to individual slides, open your presentation in Normal view. Decide which
slides you would like to add notes to. In the View tab, select Notes Page.

Click the text placeholder and begin typing your
speaker notes at the bottom of each slide.

To see how your notes pages will be printed and the full
effect of any text formatting, such as font colours, select

the View tab and switch to Notes Page view. Here, you [ COmPony Logos

can also check and change the headers and footers of
your notes.

\

Sk by ok vent

Each notes page shows an image of a slide, along with
the notes that go with that slide. In Notes Page view,
you can add to your notes using charts, pictures, tables
and other illustrations.

To print speaker notes for your presentation, select the
File tab, then select the Print tab. Select the second
drop-down menu under Settings, and click Notes
Pages. Again, you can change the orientation to either
portrait or landscape, then click Print to print the
speaker notes.

Speaker notes
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Printing an outline

Ifyou look at your presentation in Normal
view, you will see an outline of your work on
the left-hand side of the screen.

If you choose to print an outline, this is the
information that will be printed. Outlines help you
to view the whole presentation and make decisions
about where you have placed information. For
example, you may decide to add new information or
rearrange the old information.

To print an outline of your presentation, click the
File tab and select Print. Select the second drop-
down menu under Settings and select Outline, then
click Print.

Practice task 14

How can printed handouts be helpful for the audience in a face-to-face presentation?

Question 2

How can printed speaker notes help when giving a presentation?

Question 3

Why is printing an outline of your presentation useful?
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3 C Store your presentation

How you store your presentation depends on the requirements of your
organisation and who needs to access the presentation.
If your presentation needs to be available to all your colleagues, you should store it in an

appropriate place on the organisation’s server. Your colleagues can then access the presentation
from their workstation, as long as they have PowerPoint installed on their computers.

An important task when creating and editing presentations is to save your work. Saving the
presentation ensures that you can edit or print it again when required. Each organisation
has its own policies and procedures regarding naming and storing electronic documents,
and it is important that you follow these so that you and other staff can access the
documents as required.

Most presentations you create will be stored electronically. Occasionally hard copies
(printouts) of the presentations may be stored in the organisation’s paper-based filing system.

Each presentation needs to be easily identifiable. Your organisation is likely to have an
established system for naming electronic files to ensure all employees are able to find files
when required.

Folder structures and naming standards

Folders are used to organise files so they are easier to locate.

Each organisation uses folder structures and naming standards to ensure that all files are
stored in the correct location. Folders have a treelike structure that branches from a parent
directory to sub-folders in a hierarchical structure.

If your organisation has a network, you may have shared directories and folders that several
staft have access to. To set up a shared directory, you have to find the shared network drive,
then go to the folder level. This is the first place to organise the directory.

Advantages of shared directories and naming standards

* Organised files are easy to find. For example, it is much easier to find one file in 10
than it is to find one in 100.

* If an employee is away, other employees can check to see how much of a document
the employee has completed, and finish it if necessary.

e Work is less likely to be duplicated, as staff can check if a document has already
been created.

* |tis easy to share documents between employees.
* Files stored in shared directories are usually backed up on a regular basis.

* Virus scans are normally run on shared folders on a regular basis.
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SERVER (C DRIVE)

Group A
Group B
Group C
Procedures
Personnel
Projects
Project A
Project B
Project C

ProjectC_timelines.docx

ProjectC_researchl.docx

In the example structure above, the server has three folders for three separate work groups:

o Group A
e GroupB
e GroupC

Group C has three major folders:
o Personnel
o Procedures

o Projects

The Projects folder includes:

o Project A
o ProjectB
o Project C

Project C has two documents (or files):

o ProjectC_timelines.docx

o ProjectC_researchl.docx

The file path for retrieving a document starts at the server and ends when the correct

document is located. For example, to reach ProjectC_timelines.docx, the file path to
follow is:

C:\GroupC\Projects\ProjectC\ProjectC_timelines.docx
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Manage shared directories

When you have access to a shared directory to store your files, you may also
have access to files created by other employees.

It is important that you check your files and delete
any that are no longer required on a regular basis
to ensure the system remains efficient. Before
deleting any files, check which projects or clients
you need to keep files for by asking your supervisor.
You should never delete or move files created by
another employee without their permission; always
check first.

Organisations usually perform regular backups
of shared directories and folders. In larger
organisations, a staff member from the IT A
department will usually be responsible for this. ;

Hard-copy storage

Many documents stored digitally may also be stored in hard copy.

This is a safeguard against a catastrophic computer system failure. Hard-copy storage
requires space. It also requires a filing system that uses consistent, simple and meaningful
names similar to those used in digital storage.

Managing hard-copy documents is necessary to efficiently use storage space. Retention
schedules are used to determine which documents need to be kept and for how long.
Documents without permanent value may be scheduled for eventual destruction.

It is normal office practice for staff to perform archiving duties; that is, removing inactive
files and placing them in long-term storage. Retention schedules save space because only a
limited number of records have long-term value. The development and implementation of a
retention schedule also saves money, as it means that only records of enduring value will be
permanently retained.

Here is an example of a retention schedule.

Retention schedules for hard-copy documents

Credit card receipts and statements 2 years
Tax records 6 years
Accounts records 6 years
Invoices 1 year
Client correspondence 2 years
Presentations 6 months
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Prevent data loss

After creating or modifying an electronic document, you need to exit the
software application without causing damage or loss of data.

Data loss can occur when a computer program stops performing its expected function.
Often the program, or even the whole computer, may appear to freeze. Data may be
accidentally erased or corrupted and made inaccessible.

The main cause of data loss is human error. Below are a number of precautions you can take
to prevent data loss.

Work on one document at a time

Try to work on only one document at a time. If you need to work with multiple
applications open, you should close applications when they are no longer needed.
This will help your computer work more efficiently and will help to prevent data loss in
the event of computer failure.

Lock unattended workstations

Data loss can occur if someone else tampers with your work. If you are working on a
document, ensure you lock your computer or exit the application before leaving your
workstation.

Use virus protection

Other causes of data loss include damage from viruses, operating system or
application software bugs and failed upgrades. Using virus protection programs and
frequently updating software can help to prevent data loss.

Prevent computer malfunction

If your computer starts to make unusual noises or display warning messages, save
your work, then shut down the computer immediately and do not turn it back on until
you have received advice from an IT support person.

Use the correct exit procedure

Before shutting down your computer, exit all programs by selecting the exit button,
which is generally located in the top right corner of the window. Ensure you save your
work first. If you have recently made changes to your presentation, you will usually be
prompted to save before exiting.
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Network/operating system logons and security

Passwords may be required to ensure that only authorised users are able to
access certain files and information.

Access to an organisation’s data can be controlled at a number of levels, including drives and
files. Employees can be given access to shared directories or individual files.

Most organisations have networks made up of multiple computers. Before employees can
use a computer that is connected to the network, they must be issued a login username and
password, which identifies them and allows them to access the files on the network. Below
are the instructions for selecting a password and keeping your work secure. Your IT support
person should be able to give you advice on this. Alternatively, refer to the organisational
policies and procedures for password protection.

Selecting a good password

You should change your password on a regular basis and ensure you do not tell anyone
what it is. Your password should not be anything that can be easily guessed by other
people, such as your date of birth, name, family members’ names, etc. Good passwords
contain a mixture of letters and numbers, and are six to eight characters long.

Protecting individual files

Depending on the network configuration, employees will have their own drive for

their files along with access to various shared drives. Where files contain sensitive
information that should not be accessed by all employees, you can apply a password to
an individual file. Two levels of access can be applied:

e a password to open the file, which allows the file to be viewed and printed

* a password to modify the file, which will let the user make changes to it.

Practice task 15

In the following exercise, you are required to password-protect your presentation.
1. Inyour presentation, go to the File tab. Info is selected by default.

2. Click Protect Presentation and select Encrypt with Password from the drop-down

menu.
Protect Presentation
} Control what types of changes people can make to this presentation.
Protect

Presentation ~

3. In the Password box, type a password and click OK. In the Confirm password field,
re-enter the password and click OK.

Unit release 1 (Aspire Version 1.1)

74 © Aspire Training & Consulting



Topic3
Finalise presentations

Encrypt Document ? X

Encrypt the contents of this file

Password:

Caution: If you lose or forget the password, it
cannot be recovered. It is advisable to keep a list of
passwords and their corresponding document
names in a safe place.

(Remember that passwords are case-sensitive.)

Protect Presentation will now be highlighted in a yellow cell.

Protect Presentation

,.’ # A password is required to open this presentation.
Protect

Presentation ~

4. Save and close your presentation.

5. Reopen your document using your new password to check that it’s working correctly.
Close your document.

Password ? X

Enter password to open file
Presentation1.pptx

Password: |

Summary

o A presentation needs to be checked for spelling, grammar, consistency and style.

 Print presentation materials to suit the needs of the audience and the presenter. If you
are printing materials for someone else, make sure you discuss what they need before
printing.

» You can print out handouts, notes and outlines of your presentation.

» Your organisation will have a folder structure and naming standards to ensure that all
files are stored in the correct location.

o How a presentation is stored depends on organisational requirements and who needs to
have access to the presentation. There is a range of electronic storage methods available.

o The main cause of data loss is human error. Take steps to prevent data loss from
occurring.
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Learning checkpoint 3
Finalise presentations

Part A

Read the case study, then answer the questions that follow.

Case study

John works for a small not-for-profit organisation. Part of his job is to create a monthly presentation
to send out via email to the organisation’s clients. The content and format of the presentation
follows a standard outline, and John’s supervisor is happy with the comments he has received from
clients about how easy it is to read and understand. John always has a short time line in which to get
the presentation prepared because he is often held up waiting for contributions from others in the
organisation.

John thinks the presentation looks outdated and has decided that he will change the style by
changing the font type and adding some bright images and the logo in the footer. John wants to show
his boss he has initiative, so he doesn’t get a colleague to proofread the presentation as he normally
would.

1. What instructions should John follow to produce the presentation?

2. Do you think John is right to make changes to the presentation?
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3. Why is it important to get the presentation proofread before it is distributed to others?

4. Explain what methods of proofreading presentations John could use to make sure the
presentation is accurate and error-free.

Part B

Read the case study, then answer the questions that follow.

Case study

Jonah has spent two hours working on a PowerPoint presentation for a meeting that afternoon.
While working on the presentation, he kept other documents open in the background, including two
other PowerPoint presentations he had been working on and an Excel spreadsheet.

Jonah has created 10 slides and has almost finished the presentation. He leaves his desk to make a
cup of tea, leaving the documents open and his workstation unlocked. When he returns, he finds the
screen has frozen and he cannot get any functions to work. After a few moments, he gains control
and checks his presentation. He is alarmed to find that he has lost half of the presentation and only
the first five slides remain.

1. What steps could Jonah have taken to avoid losing his work?
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2. How can saving and naming procedures be helpful if Jonah fell sick and was away for a
few days before an important deadline?
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